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ZANZIBAR EXAMINATION COUNCIL
FORM THREE ENTRANCE EXAMINATION
063 INFORMATION AND COMPUTER STUDIES

Time: 2:30 Hours ANSWERS Sunday 27th December 2020.

Instructions
1. This paper consists of sections A, B, and C
2. Answer all guestions in section Aand B and C
3. All writings must be in blue or black ink.
4. Communication devices and any unauthorized materials are not allowed in the assessment room.

5. Write your Examination Number at the top right hand corner of every page.
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1. Choose the correct answer and write its letter in the table provided below.

(i) A computer is called an electronic device because:
A. It processes data

B. It uses electrical signals to process data

C. It gives out information

D. It accepts user input

Answer: B
Reason: A computer processes data using electrical signals, making it an electronic device.

(ii) Which one of the following is not true about the system unit?
A. Itis a house of CPU

B. It is a house of the monitor

C. It connects to all peripheral devices using ports

D. It has a computer power switch

Answer: B
Reason: The monitor is not housed in the system unit; it is an external component.

(iii) The two parts of a computer are:
A. Control unit and memory

B. Address and register

C. Address and ALU

D. Control unit and ALU

Answer: D
Reason: The two primary components of a computer's CPU are the control unit and the ALU (Arithmetic
Logic Unit).

(iv) Which one of the following is not an operating system?
A. Microsoft Office

B. Linux

C. Windows Vista

D. Windows 7

Answer: A
Reason: Microsoft Office is an application software, not an operating system.

(v) What is the name given to an alternative source of power?
A. Generator

B. UPS

C. Power backups
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D. Motor
Answer: B
Reason: A UPS (Uninterruptible Power Supply) provides an alternative power source during outages.

(vi) The main advantage of a laptop over a desktop computer is:
A. Faster processing speed

B. Larger hard disk

C. Smaller size hence more portable

D. Suitable keyboard

Answer: C
Reason: Laptops are compact and portable compared to desktop computers.

(vii) Two of the following are features of a spreadsheet except:
A. Formula bar

B. Name box

C. Aruler

D. Status bar

Answer: C
Reason: A ruler is not a feature of spreadsheets; it is commonly found in word processors.

(viii) Which one of the following is not a suitable application of spreadsheet programs?
A. Creating account documents and reports

B. Analyzing statistically data collected for research

C. Creating text-based documents and publications

D. Editing and formatting documents

Answer: C
Reason: Creating text-based documents is better suited for word processors, not spreadsheets.

(ix) Which of the following is not antivirus software?
A. Norton Security

B. McAfee

C. PC Doctor

D. Kaspersky

Answer: C
Reason: PC Doctor is a diagnostic tool, not an antivirus program.
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(x) In online processing technique, the remote terminal that is connected to a centralized processing
computer is known as:

A. Workstation

B. Switch

C. Server

D. Coaxial

Answer: A
Reason: A workstation is a terminal connected to a central server in online processing.

2. Match the applications in Column A with the appropriate devices in Column B. Write the letter of the
correct response in the table below.

Column A:

(i) Itis a device that transfers information between networks

(i) It provides information that can be used to calculate the location of a specific device
(iii) It converts electrical signal back into sound

(iv) It converts sound signal into an electrical signal

(v) It enables blind person to read text displayed on a computer monitor

Column B:

A. Monitor

B. Microphone
C. Loudspeaker
D. GPS

E. Braille reader
F. Router

G. Switch

H. Bridge

Answers:

(i) F. Router

(if) D. GPS

(iii) C. Loudspeaker
(iv) B. Microphone
(v) E. Braille reader
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3. (a) Identify any three benefits of information to the society.

i. Improved communication: Information facilitates effective communication through technologies like
emails, social media, and teleconferencing.

ii. Enhanced education and learning: Information provides access to knowledge and resources that improve
educational opportunities.

iii. Economic growth: Information supports businesses in decision-making, market research, and improving
productivity.

(b) State two weaknesses of the first computer generation.

i. Large size and high power consumption: First-generation computers used vacuum tubes, making them
bulky and energy-intensive.
ii. Limited reliability: They were prone to frequent breakdowns and required extensive maintenance.

4. Briefly explain the procedure required to insert the following in a document.

(i) Page numbers:

- Open the document in a word processor like Microsoft Word.

- Go to the "Insert" tab.

- Click on "Page Number" and select the preferred location and format.

(ii) Footnotes and endnotes:

- Place the cursor where the footnote or endnote reference is needed.

- Go to the "References" tab.

- Click "Insert Footnote™ or "Insert Endnote,"” then type the required information.

(iii) Header and footer:

- Go to the "Insert" tab.

- Select "Header" or "Footer" and choose a style or design.
- Type the desired text in the header or footer area.

5. (a) List down five common icons on Windows 7 desktop.

i. Computer (My Computer)
ii. Recycle Bin

iii. Network

iv. Control Panel

v. Documents
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(b) Distinguish between command line user interface and graphical user interface.

Command line user interface:
- Users interact with the system by typing commands.
- It requires knowledge of command syntax and is less user-friendly.

Graphical user interface:
- Users interact with the system using graphical elements like icons, menus, and windows.
- It is user-friendly and easy to navigate.

6. () Differentiate between the following computer terminologies:

(i) Light pen and stylus:
- A light pen is a pointing device that detects light on the computer screen and is used for precise input.
- A stylus is a pen-like device used to interact with touch screens or graphics tablets.

(ii) Magnetic Ink Character Recognition (MICR) and Optical Mark Reader (OMR):
- MICR reads characters printed with magnetic ink, often used in banking for check processing.
- OMR detects marks made on paper, such as multiple-choice answers on exams.

(b) (i) State any two characteristics of memory.

i. Volatility: Some types of memory (e.g., RAM) lose data when power is turned off.
ii. Speed: Memory speed affects how quickly the system can access and process data.

(i) Identify three types of cache memory.

i. L1 Cache: Located inside the processor for extremely fast access.
ii. L2 Cache: Slightly larger and slower than L1, located near the processor.
iii. L3 Cache: Larger and shared across multiple processor cores for efficient data access.

7. (a) What is a computer laboratory?

A computer laboratory is a specialized room equipped with computers, peripherals, and other technological
resources, designed to facilitate computer-based learning, research, and practical activities.

(b) Briefly explain any four safety precautions to be observed while working in a computer laboratory.

i. Avoid eating or drinking: Food and drinks can spill and damage computer equipment or cause electrical
hazards.
ii. Proper cable management: Ensure cables are arranged neatly to prevent tripping hazards or accidental
unplugging.
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iii. Use surge protectors: Protect computers and peripherals from damage caused by power surges.
iv. Maintain ventilation: Ensure the room is well-ventilated to prevent overheating of computers and other
devices.

(c) Mention any three things that can destroy your computer.

i. Malware or viruses: These can corrupt files and damage the operating system.
ii. Power surges: Sudden voltage spikes can damage internal components.
iii. Physical damage: Dropping or mishandling the computer can destroy hardware.

8. (a) Define the following terms:

(i) Window desktop:
The Windows desktop is the primary user interface screen in a Windows operating system, where icons,
files, and shortcuts are displayed for easy access to programs and tools.

(ii) Data:
Data refers to raw, unprocessed facts or figures collected for analysis or processing into meaningful
information.

(iii) Information:
Information is processed data that is organized and presented in a meaningful way to support decision-
making.

(b) Explain the four common mouse operations.

i. Clicking: Pressing and releasing the left mouse button to select an item or open a program.

ii. Double-clicking: Quickly pressing the left mouse button twice to open files or applications.

iii. Right-clicking: Pressing the right mouse button to display a context-sensitive menu.

iv. Dragging: Holding down the left mouse button while moving the cursor to move or select items.

9. (a) Briefly explain how you will save a word document in a computer drive.

- Open the document in Microsoft Word.

- Click on "File" in the top menu bar.

- Select "Save As" and choose a location (e.g., a specific drive like C: or D:).
- Enter a file name and click "Save."

(b) Outline five different versions of the Microsoft Windows operating system.

i. Windows XP
ii. Windows 7
iii. Windows 8
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iv. Windows 10
v. Windows 11

10. (a) Briefly explain the term networking.

Networking refers to the practice of connecting computers and other devices together to share resources,
information, and data. It allows multiple systems to communicate and interact within a local or global scope.

(b) With the help of a diagram, write a short explanation on star topology.

Star topology is a network arrangement where all devices are connected to a central hub or switch. The hub
acts as a communication channel for all connected devices, facilitating the exchange of data.

Advantages:
i. Easy to install and manage.
ii. Failure of one device does not affect the rest of the network.

Disadvantages:
i. The central hub is a single point of failure.
ii. It requires more cables compared to some other topologies.

(c) Give two differences between LAN and WAN.

i. LAN (Local Area Network) is limited to a small geographical area, such as a building, while WAN (Wide
Area Network) covers a large geographical area, like a country or the world.

ii. LAN offers high-speed connections due to proximity, whereas WAN has lower speeds due to long-
distance communication.

11. (a) Define the term spreadsheet.

A spreadsheet is an application software used for organizing, analyzing, and storing data in tabular form. It
allows users to perform calculations, create graphs, and manage data efficiently.

(b) Read the information provided below and answer the questions that follow.
Complete the table and solve:

i. Complete the table by filling F2 to F6 and G2 to G6:
F2=C2-D2

F3=C3-D3

G2 =(F2/C2) x 100

G3=(F3/C3) x 100
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ii. Find C7, D7, and E7:
C7 =SUM(C2:C6)
D7 = SUM(D2:D6)
E7 = SUM(E2:EB)

iii. Calculate C8, D8, and ES8:
C8 = AVERAGE(C2:C6)
D8 = AVERAGE(D2:D6)
E8 = AVERAGE(E2:E6)

12. (a) Differentiate between the following terms as used by the user of MS Word.

(i) File —close and File — exit:
- File — close: Closes the current document but keeps the application open.
- File — exit: Closes both the current document and the application.

(i) Save and Save as:
- Save: Updates the current document in its existing location.
- Save as: Saves the document with a new name or in a different location.

(iii) Print and Print preview:
- Print: Sends the document to the printer directly.
- Print preview: Displays how the document will look when printed.

(iv) Header and Footer:
- Header: Text or graphics that appear at the top of each page in a document.
- Footer: Text or graphics that appear at the bottom of each page in a document.

(b) Describe the essential components required for the establishment of internet connection in an
organization.

i. Modem: Converts digital signals to analog for internet access.

ii. Router: Distributes internet connectivity across multiple devices.

iii. ISP: Internet Service Provider supplies the internet service.

iv. Network cables: Connect devices to the network physically.

v. Switch: Facilitates communication between devices in the local network.
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